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Chapter 1 - Introduction

The BRIT View product is a PACS application that is based on computer
and medical imaging standards. By using these standards, maintaining
the maximum flexibility in the equipment is easily done, and costs are
controlled. By using standards, newer software upgrades can be more
easily accomplished to support the latest and greatest technological
advancements.

Since the users expect to see different ways of performing the same tasks,
this workstation was developed to complement each clinician’s reading
style as much as possible.

The BRIT View connects to the hospital network and receives images from

the specified modalities, digitizers, and servers. These images are sent to the workstations automatically, or
they can be specifically requested from a list of servers. The System Administrator can help the hospital staff
decide which studies are automatically routed to specific workstations, ensuring that prior studies are readily
available at the local workstation.

Once the exams are loaded onto the workstation, a list of all patient exams is available. After selecting an
exam, or a set of exams for a specific patient, the viewing and image manipulation window opens. Work lists
can be built by selecting the types of exams to be read by specifying the type from different regions of
interest, modalities, exam dates, or exam status. Once the exam is downloaded from the selected server, it is
available on the local hard drive whenever the user needs to access the exam.

The viewing and manipulation window supports a variety of functions that are selected from a toolbar, mouse
functions, and even some keystroke shortcuts. Users can easily move between images in the same exam or
different exams, and simultaneously view images from multiple exams by “splitting” the window. Series are
easily linked and synchronized for comparison.

The system comes with a variety of functions, such as zooming, scanning, rotating, measuring, drawing,
montage, magnification, MPR, and navigation via scout lines. For some modalities, cine is also available,
including synchronized cine motion. There are many tools for controlling how these series are displayed on
the monitor(s), and each user can design and customize the workstation to their own viewing preferences —
such as hanging protocols.

Key images are also available for the referring physician which allows the user to select important or relevant
images that can be viewed separately from the rest of the exam. Key images are separately downloadable to
the referring physician. Adapting this workflow facilitates the best utilization of bandwidth while providing the
physician an option to download the entire study, if desired. Teaching files are also supported.

The BRIT View allows a variety of users to view the patients they have permission to access, and perform a
variety of tasks on the selected study. Measurements and annotations can be made on the images, formats
can be changed, window/leveling can be set according to preferences, and a variety of other functions can be
performed on the BRIT View software. In most cases, BRIT View is used by the clinical staff including
Nurses, ER, ICU, OR, and a variety of other functions around the facility.

BRIT View can also be used by the Radiologist as a diagnostic workstation when used with a higher quality
monitor, it provides the same viewing quality as the BRIT Vision Diagnostic workstation.

Starting BRIT View

BRIT View runs on Microsoft Windows XP and is downloaded via a web browser. An icon can be placed on
the desktop the first time the application is downloaded, for ease of access.

@ BRIT View User Manual 1



Chapter 1 - Introduction

Starting the BRIT View Application

To start the BRIT View application, click on the BRIT View icon ( ) on the desktop.

The BRIT View window opens.
The BRIT View application can be set up to receive images via:

» Local only — Studies that were downloaded to the
computer requesting the study.

» Java Interface to Roentgen Files — Studies that are
stored on the central Roentgen Files server.

> Web Browser Interface — Studies that are stored at a
remote site’s server.

Using the Mouse

BRIT Systems recommends that a three-button mouse be used when working with the BRIT Vision. If a two-
button mouse is the only type available, it can be used to duplicate the functions of a three-button mouse. To
do so, simultaneously press the right and left buttons on the two-button mouse to simulate pressing the
middle button of a three-button mouse.

The uses for the three buttons generally are:

» Left button — Used to select the exam or the image
» Middle button/Scroll Wheel — Used to control brightness and contrast
> Right button — Used for special functions

Click Hold

Left Button Select icon, move to next image Pans images when image is larger or smaller than the window

Middle Calculates window and level On Image — manual adjust window and level.
Button from ROI at mouse position On Icon — drag and drop

Shows Dob-Ub menu on image Scroll through stack of images moving up/down. Mqves Cine
Right Pop-up ge- forward/back-ward moving left/right. Pops up selection menu.

g Moves to next W/L preset setting Click on toolbar button and hold to access selection for Zoom level,
Button on W/L button Format, Markups, W/L, Presets, tool box, and Image Orientation menu.

There are several terms that are used with the mouse, which include:

» "Click" or “press” or “select” means to position the mouse pointer (also called the cursor) over the
item of interest then press the mouse button once and immediately release it.

» “Left click” means to click one time using the left button on the mouse.
» “Right click” means to click one time using the right button on the mouse.

» "Click and hold" or “press and hold” means to position the mouse pointer over the item of interest,
then to press and hold down the appropriate mouse button. This type of action is used to drag and
drop items and in certain types of annotations.
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T Chapter 1 — Introduction

» "Drag and drop" means that the left mouse button is pressed and held down over
an item and the mouse is moved in the appropriate direction, then the button is
released to leave the item where it is currently placed.

Components of the Study

Each patient can have an unlimited number of studies, which can i/j\

consist of multiple series that contain various images. f— /{;\,_\’,///Q Study
==

For example, the Study would be compared to a book, the ///

Series would be a chapter in the book, and the Images would

pages in the book. 4 \ @ Series
|

— —_

_ }.E H Images

Components of BRIT View

Once the user has logged in, the BRIT View window displays. This window is has a variety of features and
toolbar buttons that allow the user to view, annotate, reformat, flip, rotate, magnify, and otherwise view the
images in each series of the study.

Once the patient is selected, either view the Local Patient List or the Browser for the list of patients on the
server, the general components of this window, are shown:

Drop-down

Menus
® | BRIT ¥iew - s1, v3 4/20/99 Cor T1 SE i TOOIbar Buttons

owser... Utlities Patient List... Print “Lacuc Format iews Format Images Zoom Close Al Help

(GE, MR, KNEE. Stdy 1 of 1: RIGHTKHEE' U Z of 4, 4 total: Img 1 of 28: 74 total Wi 1326 1L €63 Pixvalil

“ ' | \ [- 5]

Status Bar

aaaaa

Image Viewing
Area

*? 51, v3 4720199 Cor T1 SE
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]

The Drop-down menus include:

>

File — Contains a variety of menu selections to allow users to save images, create and view reports,
print reports and images, make teaching files, send images and exit the application.

Browser - Allows the user to access patient studies that are located on the Roentgen Files server or
another remote server.

Utilities — Provides a variety of efficient methods to set window/leveling values, create annotations,
work with Key Images and Presentation States.

Patient List — Allows the user to access patient studies that are locally downloaded.
Print — Allows the user to select a format in which to print images, as well as print reports.
Status — Allows the user to see the status of the study.

Format Views — Allows the user to format the series, clone series, select hanging protocols, perform
MPR on the series, and close all images in the study.

Format Images — Allows the user to select the layout for the images in the series, image labels, and
scout lines.

Zoom — Allows the user to magnify the image up to five times the captured size, and open a
magnifying glass closer viewing.

Close All - Closes all images in the study.

Help — Provides additional help for different aspects of BRIT View.

The Toolbar buttons include:

Blexe ] Displays the next image in the series.

Pre¥ | _ Displays the previous image in the series.

eXam | _ pisplays the next exam.

EEISIE

— Closes all studies that are open.

Fit

2o _ Increases or decreases the size of the image to fit to the current viewing area.

|x

2o _ Displays the image in a one-to-one pixel ratio of capture pixels to display pixels.

2x

£00m | _ pisplays the image magnified two times the original captured size of the image.
£oom| _ provides a round magnifying glass that magnifies the images five times the original size.
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Chapter 1 — Introduction

> — Turns the image top to bottom 180°.
> '; — Turns the image left to right 180°.
> D= | Turns the image 90° counterclockwise, or to the left.
> P | Turns the image 90° clockwise, or to the right.
oooo
gooo
EEET
> — Displays all image in the active series in the window.
gooo
[m[m[m[m]
et
> — Displays a montage of images.
> el Toggles between displaying all the series and a single series.
> o Click the middle mouse button on the area of interest to optimize window/level settings.
Left click to display the window/level presets.
HE?.&_
> i Re-displays the images, repaints the screen, and shows the annotation statistics for the

ROL.

> Key |_ Displays the images that have been identified as Key Images.

> _.__E;I — Save the image with the exact settings and all annotations.

> Rets|_ Displays all the available reports.

— Sets the monitors for hanging the images in the exam.

H
i
> === _ Allows the user to select a saved hanging protocol for hanging an exam.
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The Status Bar contains the following information:

Patient ID Patient Name Study Description Series Description Image Window Level Pixel
Description Value Value Value

1115118 CIARER,, CHRIS Stdy 1 of 13 CTABDOMENOWCONT Yu 4 of 4, 4 total: ABDJPEL DELAY Inglof92: 267 total  Wh 400 b 25 HUd

» Patient ID Number

» Patient Name

» Study Description

» Series Description — This value changes as the cursor is moved over the various series.

» Image Description — This value changes as the use scrolls through the images.

» Window Value — The current window setting. This value changes as the window/level setting

changes.

Y

Level Value — The current level setting. This value changes as the window/level setting changes.

» Pixel Value — This value changes as the cursor is moved over specific pixels.

The Image Border contains the following information:

® |51, v1 12/29/6 ABDJPEL SCOUT

Study Number
Series Number

Date of Exam

Y V V V

Body Part/Series Description

The Image Viewing area displays the images for the study.

Close an Exam and Exit

To exit the Exam Viewing screen and close the exams being viewed, select Close All on the main menu or

Close
All

press the button on the Toolbar. This automatically returns to the Patient Select window.

To completely exit the BRIT View application, position the mouse cursor over the small x in the uppermost
right-hand corner of the BRIT View’s main window. Click the x. This closes the BRIT View application. The
Patient Select window can be closed without closing the BRIT View application.
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Chapter 2 — Searching for Patients

The BRIT View can be configured to get images from either the local computer (the Windows PC on which
the BRIT View is running) or from remote image archives (PACS). This section describes how to use the
remote patient list (user interface) after the system has been appropriately configured.

The Patient Select dialog box always has at least one tab at the upper left labeled Local for selecting and
viewing images that are stored on the local computer. If the BRIT View is configured to access remote
archives, additional tabs appear on the Patient Select dialog box.

For each remote archive that is accessible to the BRIT View an additional tab will be present. The following
figure shows conceptually how the Patient Select dialog box points to the various image locations using tabs.

Accessing Local Patients

When BRIT View is first loaded, a window showing all the
patient studies that have been downloaded to the local BRIT
View workstation opens.

This local list can be accessed at any time by clicking on the
Patient List drop down menu.

The patient list is displayed in the upper portion of the
window.

To access a patient, click on the patient, and the studies for
that patient are shown in the lower portion of the window.

Click on the desired study and click on the

button to open the selected exam, or click on the
Wiew Al

button to view all of the studies for the patient.

(~ Exam Acquigition Dat o
" Disable " Today ¢ Last3Daps ¢ Last 2'weeks |—-—--—!

& eteery | 8/ o0e v | and | 8/ 72004 x| Concel |

Filtering the Local Patient List

After selecting the Filter the List button, the Set Filters dialog is | o s - exreuty  — nece | ClarFites |

displayed, as shown in the following figure. This dialog is used to ‘;ig;ﬁ ngD ?:ﬁgﬁum
specify the exam information that will be retrieved from the remote | i sresst I~ HEAD ™ SKULL
archive T CHEST I~ HEART [~ SPINELC
: ‘r CLAVICLE ™ HIP ™ SPINE-L
| coccvx I~ KMEE [~ SPINE-S :
The Set Filters dialog box is divided into three sections: Z .le_BtUW Ly TOSPINET | Untead Studes
— Modality S

[ Computed Fadiography I Nuclear Medicine
™ Computed Tomography ¥ Ulrasound
[~ Magnetic Resonance I~ Other

» Exam Acquisition Date
» Body Part Examined
> Modality.
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If a selection in a given section is not made, then that section does not contribute to the filtering process. For
example, if the Last 3 Days radio button is selected, and no other selection is made in the remainder of the
Set Filters dialog, then all exams from the past three days would be listed after the OK button is selected.
This could still be a very large number of exams.

The filter would be made more restrictive if a body part also were checked. For example, if the body part
HEAD were selected, then only head exams from the last three days would be listed. The filter would be still
more restrictive if a modality was also checked. So, for example, if Computed Tomography was also
selected, then only head exams from the last three days that were CT’s would be listed.

Selecting additional body parts or modalities would make the filter less restrictive. Each item selected causes
the filter to include that selected item in the search. So, using the above example, if HEART and ABDOMEN
were also selected, then the search results would include all exams from the past three days that were CT’s
of the head, heart, or abdomen.

Selecting the Unread Studies button on the Set Filters dialog box will further restrict the filter so that only
unread exams are listed.

The filtering process is applied only to data in the local archive. Once the filter has been set, selecting the OK
button launches a search of the remote archive. All searches are performed at the DICOM study level. All
exams that meet the filter criteria are displayed in the patient list.

Caution: A search should not be launched without any filter restrictions;
this could cause a massive amount of data to be returned. Once a search is
started, it cannot be canceled.

To exit from the Set Filters dialog box without starting a search, select the button. To clear the

filter and turn off all restrictions, select the button. The purpose of the button is to

quickly reset the filter so that a new filter can be defined.

Sorting the Patient List

Users can sort the Patient Select list by clicking on the various column labels in the window. For example, to
sort by ID, click on the Patient ID heading. This moves the column on which the sort has been performed to
the left-most column, and it pushes all other columns to the right. The sort can be reversed of any left-most
column by clicking in its title bar. Click in the title bar again to return to the original sort format.

Notice that the Latest Study column sorts from the oldest exam to the newest (the newest exams will be on
the bottom of the list). The Birth Date column sorts from unknown dates at the top to the oldest age and then
down to the youngest. The Patient ID sort places the numerical IDs on top from smallest number to largest
followed by the alphabetical IDs below.

The system does not remember the sort order that was set on the Patient
Select window after logging out from a session and logging back in. A new
session always begins with the Names in the left-most column, with Patient

IDs just to the right, followed by Birth Date, Sex, and Latest Study.

8 | =4l BRIT View User Manual



=== Chapter 2 — Searching for Patients

Select a Patient to View Images

After defining a filter and completing a query, the Patient Select dialog fills with a list of patients and exams
that match the search criteria. To view all of the studies for a given patient, select the patient and then the

button. Alternatively, to view a specific study, select (highlight) the desired study (at the bottom
Lo |

under the Study tab) and then select the button. This causes the Patient Select window to be
hidden and the requested images to display in the Image Viewing window. This behavior is the same
whether users are looking at images from the local system or from a remote archive.

Remember, however, that when viewing images on a remote archive, the images first must be transferred
from the remote archive to the local system. Because some image files or series may be quite large, the
transfer process introduces a time delay. The size of the delay is dependent upon the type of connection that
exists between the local system and the remote archive. Fortunately, this delay only occurs when the images
are actually transferred from the remote system to the local system. Once they are transferred to the local
system, they are stored on the local system and do not have to be transferred again (until they are erased
from the local system).

While downloading images from a remote archive, the status (progress) of the download is displayed in the
BRIT View's Status Bar. The number of images downloaded and the number of images remaining to be
downloaded are shown in the Series Description field of the Status Bar. In addition to showing the
download progress, the Status Bar also will be filled in with other information about the patient and the exam.

Selecting Multiple Patients

Multiple patients can be selected by performing the following steps:

1. Using the local Patient Select list, select (highlight) the first patient’s
name and then click on View Selected or View All. The appropriate

Warning! May be a different patient! I

images will open for to view. Warning! May be different patients!
. . . . . You h i fi kient with 1D
2. For a second patient, click on Patient List on the main menu, select the s R e
second patient’s name, and again click on View Selected or View All. Sl N R e =0

) . . CTO00000Z3
The following warning message displays.

) . . would wou like ko -:Iosg the first pakient
Select No to keep the first patient open along with the second. befare apening the next?

Users can open more patients in the same way. To see one exam at a ves No

time click the Exam button on the Toolbar. Repeat clicking on the Exam
button to view all open exams in successive order.

Select Individual Studies or Series

Select a patient on the Patient Select list. At the bottom of the screen, select the Study tab (should be
selected by default). Each study, as indicated by a Description and Study ID, is listed on a separate line.
Select only the Study lines to view and press the View Selected button. To select more than one line, hold
down the [Ctrl] button while clicking on a study line. To select an individual series, select a patient name and
then select the Series tab at the bottom of the Patient Select list. The series in all studies are listed. Each
series has a Series Number, along with the Description, Modality, Number of Images, Date, and
Accession Number, if available. Users can highlight an individual series and open it by clicking on

. If selecting only one series and clicking on the button, the entire study will open.

BRIT View User Manual 9
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Updating the Patient List when New Studies are
Added

Refresh Li
The Patient Select list does not refresh automatically. The Patient Select window has a ﬁ

Refresh Li .

button. Selecting the ﬁ button causes another query of the remote archive to be made. The query
uses the current filter settings. So, if any new patients, studies, or series have been added since the prior
query, they will be shown in the new query results. Refreshing the list keeps it current.

As described above, when an exam is selected from the remote list for viewing, the corresponding images are
transferred from the remote archive to the local system. The images are then stored on the local system (that

Refresh Li :
is, they are now local). Selecting the S button under the Local tab of the Patient Select dialog

will cause any and all exams that have been transferred and are on the local system to be listed under the
Local tab.

10 |52 BRIT View User Manual
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In the BRIT View application, the reading and diagnostic screen is called the Exam Viewing screen. After
selecting one or more patients, studies, series, or images for viewing, the Patient Select window (or Patient
Panel on the Roentgen RIS) is hidden and the Exam Viewing screen displays, as shown in the following

figure.

Drop-down
Toolbar

® | BRIT View - 51, v1 1/24/6 3 PLANE LOC.
Eile Browser... Utlides PatientList.., Print - format Wisws  format Images  Zoom Close All..  Help

123156 JOHHSON, JOHNMIE Stdy 1 of 1 LUM.SP. Vu 6 of 8, 8 tatal: A% FSE TIFS C+ Ima 1 of 31 161 total Wi 1366 Li 683 Pixvals

s1, vl 1/24/6 3 PLANE LOC.

Status Bar

uuuuu

Viewing Area

Series/Image
Border

it

wouT
| 7

w3ol
i

The BRIT View main menu has Drop-Down Menus for image-related tasks. Most of the choices also are
available through the pop-up menu accessed by clicking the right mouse button on an image. The image
viewing area is directly below the main menu and Status Bar.

A Toolbar with large icons (buttons) is present on the right side of the screen in a single monitor system. On
a multi-monitor system, Toolbars can be present on each monitor.

The Status Bar for the selected exam is at the top of the screen, just below the main menu bar. If more than
one series is in view, each series displays in a separate window, as shown in the previous figure (for eight
series on a spine). The content of the Status Bar refers to the active (highlighted) window. The left-most end
of each series’ title bar has some status information, mostly used during DICOM communication.

m BRIT View User Manual 11
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The Status Bar contains the following information:

Patient ID Patient Name Study Description Series Description Image Window Level Pixel
Description Value Value Value
1115116 CIARER,, CHRIS Stay 1 of 1: CTABDOMENOWCONT u 4 of 4, 4 tatal: ABD/PEL DELAY Imglof92:267total Wi 400 L 25 HUed
> Patient ID Number
> Patient Name
» Study Description
> Series Description — This value displays the description of the currently selected series in the

currently selected study.

» Image Description — This value causes the field to be updated with information about the image
currently being pointed to is displayed.

» Window Value — The current window setting. This value changes as the window/level setting
changes.

> Level Value — The current level setting. This value changes as the window/level setting changes.
» Pixel Value — This value changes as the cursor is moved over specific pixels.
When downloading images from a remote archive, the status (progress) of the download is displayed in the

BRIT View's Status Bar. The number of images downloaded and the number of images remaining to be
downloaded are shown in the Series Description field of the Status Bar.

The Image Border contains the following information:

® |51, v1 12/29/6 ABDJPEL SCOUT

Study Number
Series Number
Date of Exam

Y V V V

Body Part/Series Description o

The Image Viewing area displays the images for the study.
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Scrolling Features

Several methods are available for stepping (scrolling) through a series of images.

1.

If one image of a series is currently being displayed, placing the mouse cursor on that
image and clicking the left mouse button will cause the next image of the series to be
displayed.

Selecting the Next button or the [—] button has the same effect as left clicking with the mouse.
To back up through the series of images, select the Prev button or the [«—] button.

If a montage of images is being displayed (for example, a 3 x 2 array), selecting the Next or [—]

button will cause the next six images from the series to be displayed. Selecting the Prev or [«]
button will cause the prior six images of the series to be displayed. In other words, the montage is
filled with the next or previous set of images from the series.

The mouse also can be used in other ways to dynamically step through a series of images. It does not matter

if the images are displayed in a montage or in stack mode.
1.
2.

Click the right mouse button to get the pop-up menu and select format Images.

If the Scroll Stack option on the pop-up menu does not already have a check mark beside i,
select Scroll Stack.

Place the cursor about in the middle of the image.

Hold down the right mouse button, and drag the mouse up to move forward through the series and
down to move backward through the series.

To turn off scrolling, right click the mouse to re-display the pop-up menu, and select Scroll Stack
again. This will remove the check mark.

To scroll through images automatically, use the Cine function.

Holding down the [—] button will cine forward through a series.

Holding down the [«—] button will cine backward through a series.

Moving from Series to Series, Exam to Exam

The Exam button is used to select one exam to view from all the exams open on the monitor, and then to
switch from exam to exam.

1.

2.

3.

First, select the exam to view first by clicking the left mouse button anywhere in the exam’s visible
area.

Select the @ button. The selected exam now occupies the entire monitor.

Press the eXam| button again to view the next exam that is open.

|24 BRIT View User Manual 13
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Removing a Series/Exam from View

An exam can be removed from the group of exams currently being viewed. To remove an exam from view,
use these steps:

1. Select the exam to be removed. This action will make that exam’s window the active window.

2. Closing only the active window then removes the exam. To close the window, [ —
click the left mouse button on the small x in the window’s upper right-hand i ]
corner. The window (and its associated exam) will be removed.

3. The icon just to the left of the x maximizes the window size, and the one to the left of that (the minus
sign) minimizes but keeps the window open.

Comparing between Image Series (Other Exams)

To compare images between two different exams:

1. From the Patient Select screen, select the first exam (or BT TR R TR i1 j (=1 =T 118 110111 i}:{_i
series in the exam) users wish to compare. Users can select
individual exams or series under the labeled Study and Warning! May be different patients!

Series tabs at the bottom of the screen. You have images open fram a patient with ID;

2. Select View Selected (or, to compare all of the study, select M o
‘fou are requesting images for one with - ID:

View All). The selected exam will open in its own window(s) CTO00000ZS

across the Viewer.
. . . . . ‘ould you like to close the First patient
3. Click again on Patient List on the main menu bar to see the befare opening the next?

Patient Select screen.

4. Select the second study to use in the comparison, and press s b

View Selected or View All. A warning message as shown
here first displays to let the user know that that another patient is being selected.

5. Select No on this warning dialog. All exams will then display on the monitor, and users can enlarge
them individually if necessary.

6. The exams open on the screen with each series stacked. One exam will be on the left half of the
screen (or on the left-hand monitor) and the second exam will be to the right.

7. To return to a single exam view, highlight one of the series in the exam to be displayed alone on the
screen, then select the Exam button from the Toolbar. Selecting the Exam button again displays the
other exam.

8. To view the exams on the same screen again, from format Views on the main Toolbar, select All
Views (V). The [v] hotkey also acts as a toggle between one exam and all exams.

9. To compare an exam with one that had not been selected originally (if it is another patient’s exam),
then without using the Close All button, select Patient List from the main menu bar. This will again
display the Patient Select window.

10. Select the third exam to compare, and select View All or View

11. Selected. A warning message as shown above first displays to let user know that another patient has
been selected for viewing. Select No again.

Close
12. Select 2" |to close all of the exams simultaneously.

14 V=004l BRIT View User Manual



Chapter 3 — Viewing the Study

Title Bar of the Active Image

Each series is displayed on the Image Viewing Screen in a separate window, with a title bar, description, and

the set of three buttons that users see at the left.

Clicking the left-mouse button on a title bar it
becomes darker and is designated as the active
window. Users can move series of images around
on the screen by using the mouse and dragging
and dropping a window by its title bar. If the user
clicks on the right-most red X in the title bar, that
window will close. Clicking on the minus sign
causes the window to minimize, while clicking on
the middle button causes the window to maximize
(fill the monitor viewing area).

If the user clicks the right-mouse button on a title
bar of a series, an information box (Information
re This View) displays that shows patient, study,
series, and image information, as shown in the

following figure. The L A button closes the

box.

Information re This Yiew:

This PATIENT:
Patient |D: 2248, Sex: F, DOB: 09/03/1999, Name: GE, CT ERAIN

This STUDY"
Study 1 of 1 open, Dese: CT HEAD W0 CONTRAST
Study comments:

Thiz VIEW: 2 of shidy
2Views of study, “otal 2, Desc: &AL Bx5

Active IMAGE: 3 of view
32 images open inthis view, 33 tatal images open
Image comments:

OTHER infa:
Study haz 0 reports currently open, O key objects

Ful Dump

The | e | putton provides a complete computer listing of all DICOM parameters in a Notepad dialog box.

[ Z=4l BRIT View User Manual

15




Chapter 3 — Viewing the Study

16

V=il BRIT View User Manual



Chapter 4 — Changing the Layout

The ability to change the layout of the study is accomplished easily
in order to view other images in the study or to compare a previous
study to a current study. This is called changing the layout of the
study or the series.

Initially when the images are loaded into the Viewing area, it is
shown as one series per window. The layout of the study or the
series can be changed by:

» Clicking on the desired layout from the Toolbar button
» Right clicking on the image, selecting Format, and selecting the
desired layout from the drop down menu

As additional series are selected, the viewing window changes to
accommodate the new series. Therefore, if a second study is selected, the window is divided in half so that
the images from both studies are shown.

Using Multiple Monitors

An image viewing system for BRIT Vision can be comprised of up to two monitors for viewing because these
are systems used typically used by referring or performing physicians; whereas, systems used by radiologists
for diagnoses will commonly have from three to five monitors.

If users have a system with multiple monitors, when the user first starts up and logs in, the Patient Select list
(or Patient Panel when using the Roentgen RIS interface) opens on a single monitor. Users can drag and
drop these windows to another monitor. The desktop is spread across all monitors. The main menu remains
on the left-most screen, and the Close and Minimize buttons move to the rightmost screen. When images
are open, the Toolbar is present on all screens.

The single cursor can be controlled by the mouse and moved across all monitors as if they were one large
screen. When multiple series are opened, each series displays in its own active window in stacked mode.
The following three subsections describe various possible scenarios for displaying images on multiple
monitors.

Opening a Single Image

If the user opens an exam with a single image, that image opens on the left-most monitor. In some cases, if
the user is retrieving images through the Roentgen RIS interface, a single image opens on the monitor just to
the right of the Patient Panel.

Opening Two Studies

If the system has two monitors, when the user opens a patient with two studies, the first study opens on the
left-hand monitor and the second study opens on the right-hand monitor, even if study one has only a single
image and study two has multiple series and dozens of images. If there are several series stacked on each
monitor, and the user drags one of the open series from one monitor to another, the entire study switches

nse
All

monitors. When is selected on any of the monitors, it closes all studies on all monitors.

@ BRIT View User Manual 17
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If the system has two active monitors and the user opens studies or series that are spread across the two
monitors, the user can minimize or close the study or series on one monitor and press the Split button on the
other monitor’s Toolbar to spread the visible study or series to both monitors, with a single image on each
monitor. If the user then presses Next or [—], both images change to the next two in the series. Pressing
Split again will equally divide all images or series across both monitors. If the user then clicks on a different
series title bar to make it active and press Split, that series spreads across the two monitors as individual
images.

Working with Multiple Series

If the system has monitors with one or more stacked series open and the user selects one of the series to

make it active and press the | button, every image in
that series is opened in that window. The entire monitor
screen is not filled, only the active window. Each of the
multiple images are reduced in size below a one-to-one
pixel replication show the word “Minified” at their lower
right, as shown in the following figure.

Pressing the Set button on the Toolbar causes an active
window to display in a montage of images. The format of
the montage is calculated by the program and is based on
the number and shape of the images in the series.

If the user has a study displayed in which all series are
stacked across multiple monitors, and the user selects the
maximize button of an active window, that series is
displayed as a single image on each monitor (with I:1 on
the left-most monitor, 1:2 on the next monitor to the right, and so on for each monitor on the system).

If the user opens only a single series for display across several monitors, the images display initially at one

00

oo
ooo
[ wa
231

button, each monitor shows an equal number of the available

o

button, a calculated montage of images based on the number and

per monitor. When the user presses the
button is inactive in this situation. The
gooo
ogoog

sl

(=)
multiple series. If users try the | »!
shape of the images is provided.

images. The button applies only to multiple studies and

One Yiew COnly [

Using the Format Views Menu o

The format Views option from the main or pop-up menu provides the ability to Mexct Wiew {down)
perform various types of screen formatting, as shown here: Mk Exam/study (%)
Tile - Stack. all M
The options include: Allviews/Imgs  (Chrk-A)
» One View Only — places one image on each monitor from the active series. MPR this View (M}
If images from one series are open in a three-by-two montage, nothing will Clone this View (<)
change by pressing One View Only. bk Ve w
Group Yiews (@)
» All Views — places all series on a screen (or on multiple monitors). This is HngNGAtes D
applicable when multiple series already are open. Select Hanging  [Ctl H)

Save Hanging {Shft+H)

» 1 View per Screen — places one image or series per monitor, depending on _
Delete Hanging

whether multiple images or multiple series are open.
Close all {Esc)
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Next View — activates the title bar of the next successive series when multiple series are stacked on
one or multiple monitors. If only one series is visible (One View Only) but multiple series are open, it
displays the next series in the study.

Next Exam/Study — opens the next exam if multiple exams are open.

Tile - Stack All — causes images to be formatted as stacked series across all monitors, if multiple
monitors are in use. This option often is used after using the All Views/Imgs option described below.
If multiple studies are open, all studies and series will be stacked.

MPR this View — provides a Multi-Planar Reconstruction view of the selected series in the study.
Clone this View — provides a duplicate copy of the selected series in the study.

Link Views — synchronizes the selected series so that when the user scrolls through the master
series, the clone scrolls through at the same time.

Group Views - only the series data associated with each study.

Hang Monitors — allows the user to define different Hanging Protocols, or layouts and desired
settings for the studies when they are first opened.

Select Hanging — allows the user to select the desired Hanging Protocol for the open study.
Save Hanging — allows the user to save the current settings and define it as a Hanging Protocol.
Delete Hanging — allows the user to remove the selected Hanging Protocol.

Close All — closes all open exams for the patient.

Using the Format Images Menu

Control over the formatting of images allows the user to decide how many 5"-"%"3 Ir,”age (A)
images are simultaneously viewed on the screen. A multiple image screen is e e (A)
referred to as a montage of images. To change the format of images select 1 Wide (Ceri+1)
format Images from the main menu or pop-up menu and the following menu 2 Wide (Chri+2)
displays. 3 Wide {Chrl+3)
The formatting choices are: ! W?de [enki
5 Wide [Chrl+5)
> Single Image — shows one image on the window. 2 High {CErl+0)
Entire View — display all images for the series. e
» 1 Wide — shows the images in a single image on the window. Reorder Inages (00}
» 2 Wide — shows two images side-by-side on the window. o Scroll Stadk
> 3 Wide - displays three images side-by-side on the window Cine
. . ) ) ) . v Image Latels (CErl+L)
» 4 Wide - displays four images side-by-side on the window. S (Ctrl+5)
» 5 Wide — displays five images side-by-side on the window.
» 2 High — displays two images on the window one above the other.

The other selections in the Format Images menu include:

>
>

>

Process Image — provides heavy, medium, and light edge enhancement on the selected image.

Reorder Images - allows the user to reverse the order of images or to move around one or more
images on a montage.

Scroll Stack — must have a v to allow the user to hold the right mouse button down to scroll through
the series of images.
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» Cine — when in Stack mode, allows the user to have the system provide a simulated “cine” loop of the
images in rapid succession.

> Image Labels - this option turns ON and OFF the DICOM-based labels generated by BRIT for the
study.

» Scout Lines — enables the line to appear on the scout image to provide cross-sectional reference of
the selected location on the image as compared to the Scout.

Using the Pop-up in the Viewer

Since the Toolbar only provides the formats of one-up, two-up, four-up, nine-up, or All formats and
occasionally a different format is desired, additional layouts are available by right-clicking on the viewing
window, and a pop-up window opens as shown here:

Select Format and a second menu opens to show a list of available formats. Scroll down to the desired
format, click on it, and the format changes to the selected layout. The layouts available through this method
include:

Stack

Two/page

Four/page

Six/page

Nine/page

Twelve/page

Sixteen/page

Twenty/page

One by Two — this layout displays one column by two rows of images.
Two by One — this layout displays two columns in one row of images.
All — this layout displays all images in the study or series. The format used depends on the number of
images.

Rearranging the Order of the Series

When there are multiple images of a series displayed on one or more monitors, the user can:

VVVVVVYVVYY

» Rearrange images in reverse order
» Move a single image to another location
» Move groups of images to another location in the series.

The following subsections describe how these features work.

Order Images in View

To Reverse Order a Series

Mote: You can also use mouse + Shit or

1. From the main menu bar, select format Images and then Cirl — drag/drop to change arder.
Reorder Images [O]. The following Order Images in View
box displays Reverse

) Order Select buton, range,

2. The default value shown in the Image Range is the entire Jriginal or Click to set order.

series. However, the user can select to reverse images in a Ord
: . . raer —Image Range

number range. [Images in a displayed series are numbered — - o
starting in the upper row, left to right, and then repeated on the DOME I_ II g I II
next row down and other rows below that.]
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Reverse
Order

Select the Image Range, and then select the button to reverse the order of the images.
Onginal |

Select the __2™&_| putton to place the images back in the order they were in when the series was

first opened

Select 2| when finished ordering images as desired. Regardless of the order in which the
images are Ieft when the study is closed, the images display the next time in their original order.

To Move an Individual Image

An individual image can be moved from its original location to any other location by using the following steps:

Place the images in a montage mode, for example, display a single series and select the
button, or display in a montage of four images wide.

Determine the image the user wants to move, and move the cursor over that image.

Depress the [Shift] key, hold down the left mouse button, and drag the image to its new location. The
image on which it is dropped moves to the left, and all the remaining images move to the right and
down.

To Move a Group of Images

A group of images can be moved similar to the way an individual image is moved by following these steps:

1.
2.

3.

o o

Changing the Layout of the Study

The ability to change the layout of the study is accomplished
easily in order to view other images in the study or to compare a
previous study to a current study. This is called changing the
layout of the study or the series.

Initially when the images are loaded into the Viewing area, it is
shown as one series in each wmdow with one image d|splayed

on the desired image, and by:

Place the cursor over the first image in the range of images users want to move.
Depress and hold down the [Ctrl] key, and click once with the left mouse button (do not hold it down).
An open parenthesis appears on this first image.

While users continue to hold down the [Ctrl] key, move the cursor to the last image in
the group to be moved. Notice that a closed parenthesis bracket moves across the
images. Depress and hold down the left mouse button on the last image. Continue
holding down the [Ctrl] button. The following symbol appears:

While holding down the left mouse button and the [Ctrl] button, drag the group of
images over to the image where the image is to be moved and release the mouse
button and then press the [Ctrl] button. This drops the images. Notice that after the
mouse leaves the last selected image, the following symbol appears to indicate
movement:

The entire range of images is inserted between the image where the

cursor is released and all images to the right and below it.
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» Clicking on the button from the Toolbar.

» Right clicking on the image, selecting Format Images, and selecting the desired layout from the drop
down menu

Click on the Format Images drop-down menu and selecting the desired layout.

The button is used to view all images in an active series. Click once to view all images; click again to go
back to the single image view (stacked).

ooog
goo
[pdsials

Sk

~aoo

Click on the button and the currently active window divides into smaller windows to show all of the
images in that series. The images do not necessarily fill the entire screen but only the area covered by the
single series window.

e users want to see only the images in one series, expand

oo
ag
an
a1

If multiple series windows are open showing and th

e
“ooog |
oo
I"C

=

that series to fill the entire screen before selecting

The button acts as a toggle switch. It toggles between two different representations of a series (exam).
The representations are the currently selected montage of images and a single image.

Using the Split Button

When a single exam with multiple series is displayed on the monitor, the user can toggle between displaying

-

button toggles between the active single series and all the exams.

all the series and a single series using the button on the Toolbar. When multiple exams are opened,

un]

To rearrange series within an exam, select the top border (title bar) of the series to move, and use the left
mouse button to drag its upper left-hand corner to the desired position; then release it. The series from that
location and others to the right and below it will slide left to right, top to bottom.

Using Cine Mode

The Cine function automatically displays the images of a series in looping succession. When the last image
of the series is displayed, the first one is redisplayed and the loop repeats. The series of images must be in
Stack mode to use Cine. To use the Cine function:
1. Select an image from a stacked series of images. If the images are not displayed in Stack mode, an
error message displays.
2. With the mouse cursor inside the image window, click with the right mouse button. A pop-up menu
appears.
3. Select format Images from the pop-up menu. A secondary menu displays.
4. Select Cine from the secondary menu. The images in the series start displaying in succession.
5. The display rate can be controlled with a slider control that
appears, as shown here” Cine Control

then the

. . 1 | (] 1 1 1
The slowest speed is about two images per second. Slow i Fast  Stop
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The fastest speed makes the video display look like a rapidly moving picture. To end the Cine display, select
the Stop button on the slider control.

The Re-New Button

Fle___ﬁ_
The _M* | button is on the Toolbar and has several functions related to formatting the view during the routine

use of the BRIT View, as follows:
» Repaints the screen if other Windows boxes get displayed in this application.

» Closes the right mouse click pop-up menu without changing the image being viewed.

> Displays statistics after drawing with the Annotate options Freehand ROI, Ellipse ROI, and
Rectangle ROI.

» Forces a re-display of all of the images currently visible.

» Repaints the screen if the screen displays some black images.
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Chapter 5 — Magnifying the Images

To manipulate the images in the study, the magnification, size, and orientation of the images can be easily
changed by selecting one of the magnification or orientation buttons to implement the desired changes. This
section covers Zoom, Magnification, the Magnifying Glass, and Adjustable Zoom settings.

Magnifying the Images

There are three ways to magnify the image:

» From the Toolbar
» From the Zoom drop-down menu
» From the pop-up window by right-clicking in the image window

If the image is magnified, and is larger than the viewing area, click on the image with the left mouse button,
hold the button down, and drag the image around the Viewing Area until the desired portion of the image is
shown.

To enlarge an image from the Toolbar, click on the image and click on the toolbar magnification level. The
image is resized to the magnification level selected.

There are several magnification levels available through the Toolbar, which include:

Hit

> Zoom

— Enlarges the image to fit the page.

x|

> Zoom

— Sets the magnification to the original size of the image.

2x
> £09M |_ Fniarges the image to twice the original size of the image.

There are also several magnification levels available through the Zoom drop-down menu,

which include: Adustable
w Fit window (F)
> Fit Window > X1 %1 (1)
X 1.5
> X1.5 > X2 w2 (2
> X3 > X5 zg g
> X.05 » Magnifying Glass X0.5(0)

Mag Glass 3
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Finally these same magnification levels are available through the Zoom pop-up menu. e :
To enlarge an image using the pop-up, right-click on the image, select Zoom, and select | formatvens
T

Adjustable

the magnification level. The image is resized to the magnification level selected, which ™ figrotete M Ftwidon
include: gt ] e
wfindowfLevel MwXz (@
> Fit Window > X1 Key/Mark/Report Mox3 @
Mag Glass b5 (S)
Im;aqe Labels (Ctrl+L) 05D
> X1.5 > X2 Scoutlines  (Crks)
> X3 > X5
> X.05 > Magnifying Glass

Magnifying Glass -

Q

Zoom

A magnifying glass is available for the images by selecting the button. This places a magnifying glass
on the selected series, and it can be moved to the desired area by left-clicking on the glass and dragging it to
the desired area. , -

The size and shape of the magnifying glass can be changed
by left-clicking on the anchor points (one of the four corner

points marked with a °) and dragging it to the desired location
and shape and releasing the left mouse button.

format Images
Format Yiews

The Magnifying glass is also
available through the Zoom pop-
up menu. To turn on the
magnifying glass using the pop-up,
right-click on the image, select
Zoom, and select the Magnifying
Glass and select the magnification (-
size of 1X, 2X, 3X, 4X, 5X, 6X, 7X or 8X. The image is resized to the
magnification level selected.

Zoom

Flip{Ratate
Annokate
Save/Print
WindawjLevel
KeyMarkjReport

2
b
e
3
3
3
3
L
Hw Mag On (Alt+m)

Image Labels {CEr4L)
Scout Lines (ChrHes)

Q

Zoom

To turn off the Magnifying glass, click on the

Adjustable Zoom

The Adjustable Zoom feature is available for single images in a window. To access this feature and turn it
ON, select Zoom from the main or pop-up menu, then select Adjustable. This adds a check mark beside the
Adjustable option, and the option stays active for the currently active series until the user clicks it again to
remove the check mark. While holding down the right mouse button, move to the right to enlarge the image,
or move to the left to make the image smaller. This is also known as “Smooth Zoom”.

button again.

The magnification setting under Zoom on the main or pop-up menus can have a value

of 0.5X, 1X, 1.5X, 2X, 3X, or 5X. This setting refers to the original image data, whereas

the magnification under the Mag Glass option (available range is 1X through 8X)

refers only to the magnifying glass. With this in mind, if users have an image with the

magnification set at 3X and users set the magnifying glass at 1X, the image under the
magnifying glass will be minified to 1X.
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Panning

If an image is displayed at a size so that not all of it fits on the screen, drag the image around the screen to
bring off-screen portions of the image into the viewing area. This is called “panning”. To pan an image, press
on the left mouse button and hold it down, then drag the image around the screen. Once the image has been
panned, if the user chooses another image from the exam, it will be positioned likewise. This function does
not work if the entire image is visible in the display.
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Chapter 6 — Rotating/Flipping Images

The manipulation of images in the study, by rotating or flipping the images, can be easily changed by
selecting one of the orientation buttons to implement the desired changes. This section covers Rotation and
Flipping of the images.

Rotating the Images

The images can be rotated 90° clockwise or counterclockwise by any of the following two methods:

» From the Toolbar
» From the pop-up window by right-clicking in the image window

To rotate an image from the Toolbar, click on the image and click on the toolbar rotate button. The image is
rotated 90° in the direction selected.

There are two rotation directions available through the Toolbar, which include:

> 2= | — Rotates the image 90° counterclockwise, or to the left, for each time .
the button is selected. ] )

> P | _ Rotates the image 90° clockwise, or to the right, for each time the

button is selected.

Finally these same rotate functions are available through the Flip/Rotate pop-up o s

menu. To rotate an image using the pop-up, right-click on the image, select ..
Flip/Rotate, and select the direction. The image is rotated to the direction MEE=E

Annotate

Leftjright Flip
Topfbaottam Flip
Clockwise Rotate
CounkerCW Rotate

LR ahd ~ B2 AR

selected, which include: =
. KeyiMark/Report
> Clockwise Rotate e
Image Labels (Ctrl+L)
> CounterCW Rotate somnes aniie)

Flipping the Images

The images can be flipped top to bottom or left to right by using either of the Flip buttons on the Toolbar or the
pop-up menu. Each time the button is selected the image flips accordingly.

— Flips the image top to bottom for each time the button is selected.
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1

>

Finally these same rotate functions are available through the Flip/Rotate pop-up menu.
To flip an image using the pop-up, right-click on the image, select Flip/Rotate, and select

the direction. The image is flipped to the direction selected, which include:

— Flips the image left to right, for each time the button is selected.

» Top/Bottom Flip to flip the image top to bottom for each time the button is  tuma: mase: L
format Views [

selected T o
. . ) . ) . . FlipjRotate: 1§ Leftiright Fiip
> Left/Right Flip to flip the image left to right, for each time the button is o | Jombetrle
selected. window/Level b CourberCW Rakste
KeyiMark/Report b
Mag Glass 3
Image Labels (Ctrl+L)
Scout Lines (Ctrl+5)
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Chapter 7 — Window/Level, Edge Enhancement

The window and level settings allows the user to change the range of densities being
viewed on the screen. There are several actions that can be taken to change window and
level settings, including preset values and manual settings. Window and leveling are the
adjustments used for brightness and contrast control for the images.

To adjust the Window and Level control, place the pointer over the region of interest or
tissue type, and click the middle mouse button once. This provides an optimized window
and level for that region. For example, place the cursor over the bone in a CT image and
press the middle mouse button, the system will use preset values to set the window and
level to a bone window.

The middle mouse button also functions as follows to make fine adjustments in Window and Level when held
it down and moved:

» Move the cursor up to narrow the density range.

» Move the cursor down to broaden the density range.

» Move the cursor left to view the lighter shades of gray.
» Move the cursor right to view the darker shades of gray.

The adjustments in these regions are quite fine, and the actual values can be seen at the upper right part of
the Exam Viewing screen. If the user wants to reset the values to their original value, select the W/L Reset
button on the Toolbar.

Window/Level Presets

Window and Level values for various tissue types are displayed using preset values from system files when
users use the BRIT View. The System Administrator can change these initial default values. However, users
can adjust the preset values for different modalities after images are displayed by following these instructions.

1. Display the image (or image series) and make it the active Login for Local Operation

image.
Select Utilities from the main menu. I zer Mame; |
3. Select Setup from the drop-down menu. A secondary menu
displays.
4. Select Window/Level Presets from the secondary menu. The Q.

following Login for Logical Operation box displays.

5. Enter the special password users have been given, and press OK. Some systems do not require a
password; in that case, any string of three or

more alphanumeric characters will work as a  [EaRERMEEERE &
valid Iogin. ELRRENIS AL R WL TYPE: DEFAULT \CQGELUW.

6. The following Manage Window/Level | "o AT G -
dialog box displays. This box displays with s 1) [ =a | [ T Tleel] [ec |
a default setup, normally showing the values i Cance
for the first modality in the alphabetical list of
available modalities. In the following
example, the first modality in our list is CR
(on the left side of the dialog box). The
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, _
.

10.

11.

12.

13.

14.

15.

16.

Modalities area on the left also contains three buttons: Edit, Remove, and Add.

To view the different preset Window and Level values for a modality, press the small down arrow on
the Modalities field and select the desired modality from the list. The values will change to those for
the selected modality.

To add a new modality to the list, click the Add button RETEL AT
on the left side. The following Modality Entry dialog

box displays. The same box displays for Edit except | i-paty I
that the modality name is present. Cancel

Type the new modality code (two letters) and press
OK; if a mistake is made, use the Edit button or highlight the entry and press Remove.

The right-hand side of the dialog box, labeled Window/Level, is for setting W/L values for images.
Each modality will have two preset

levels called INVERT and MINMAX.
The MINMAX values cannot be CURRENT VALUES T
changed; these are for showing the LEVEL:
biggest W/L available. The INVERT | M""m= i

. e G ~ Edi Edi WilType | ‘Window | Level | ok,
values are initially set at zero, but they Le2]) L= S Lo |
may be changed. INVERT is for T T Cance
revealing a reverse contrast. One or e, R =

SOFT_TIS 400 50

more other values may be present, as in
the following screen for CT exams.

If the user selects a modality and tissue
type and presses Edit, the following
dialog box displays. Users can erase
and type in new WINDOW and LEVEL values, and can also change the TYPE, if a different name is
preferred.

Window/Level Entry

When all the desired changes are made, press the

| button to store those changes. If the | & [BONE I
user decides to keep the original settings after | WINDOW: |1500
some changes have been made, press the LEVEL: |750 Cancel

Cancel

button; in this case, the changes are

not kept.

To add a new TYPE and its settings, press the Add button on the right side of the Manage
Window/Level dialog box. The following dialog box displays.

Type in the new TYPE name and values and press

Window/Level Entry

If the Remove button is used to remove a modality TFE: | |
or a W/L setting, no warning message is displayed;
the item is simply removed. Users can restore the
screen to the original settings by pressing the Reset | F¥EL | sl

DKl

S DD I

button at the far right.

After one or more values are changed, save these new presets for W/L pressing the L

button. If changes are made of any type and the users do not press , the user can return to
image viewing without saving the changes by pressing the h button.
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While viewing an image or series of images, if press the W/L button on the Toolbar and a dialog box similar to
the following displays. -
. . . . Select Window/Level - CT g|
The system recognizes the type of modality for which images

i i i i wiil Type window Level
are displayed, and displays the corresponding settings for that e |1500 I?ED 1

mOdaIlty BRAIN 100 a0 " For gtudy
. . IMITIAL 300 50
Users can then select a W/L Type and the values in that line are INVERT D 0

applied immediately to the image(s). :LUNG e i

Clicking on For Study and activating that radio button first, the
changes are applied to the whole study being viewed.

If the user makes changes and then presses , the W/L
changes back to the originally stored values.

If the user selects the option Invert, the user must do another
Invert to return to your original settings.

Manual Adjustments for Window/Leveling

In addition to the preset values for window and leveling, the users can manually adjust the setting by using
the some other features, such as:

To manually adjust the Window (Brightness) and Leveling (Contrast) over the entire range of
values for the image, hold the middle mouse button down and move the mouse.

To automatically get optimum Window and Leveling settings on the image, relative to where the
cursor is placed (either on bone or tissue), click with the middle mouse button.

To select the Window/Level setting for the image, left-click on the T 5
Maode . . Wil Tupe | “wiindow | Lewvel 1
button, and the Select Window/Level dialog box opens. -FOHE 1 2o e
Click on the desired setting and the window/leveling settings INITIAL 300 50
change, on the selected series. INVEELT g i

_LUNG 1100 E50

MINML WIDE MID
SOFT_TIS 400 50 m
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Edge Enhancement or Image Processing

Edge enhancement uses digital image processing to increase the contrast, or pronounce the edges, on an
image to enhance the details of the image resulting in a more detailed image that makes it easier to spot
minute tissue textures, bone fragmentation, or subtle color variations on the mucous membrane. Edge
enhancements are predominantly used with CR and film digitized images.

One of the features that helps greatly with Edge Enhancement, particularly with bone is Reverse Contrast.
When used in combination, these two features can help the radiologist easily identify fractures or breaks in
bone. For example, a CR of a hand in a normal window/level view is shown below, as Sample 1.

A CR of the same hand with Reverse contrast turned on is shown below as Sample 2.

A CR of the same hand with Reverse Contrast turned on, in combination with Small Edge Enhancement is
shown below as Sample 3 which provides a minor edge enhancement to the current image.

A CR of the same hand with Reverse Contrast turned on, in combination with Big Edge Enhancement is
shown below as Sample 4 which provides a heavier edge enhancement of the current image.

Sample 1 Sample 2 Sample 3 Sample 4

Normal CR View Reverse Contrast On  Reverse Contrast On Reverse Contrast On
Sharpen Off Sharpen Off Sharpen Light Sharpen Heavy

The Edge Enhancement or Process Image feature allows users to enhance the edge definitions within an
image by using the mouse and a pop-up menu option. This feature does not work on a frame-grabbed or
scanned image.

1. Select format Images on the main or pop-up menu.

2. Move the mouse over the Process Image option, and the following 1 Sharpen Heavy (F4)
sub-menu displays: 2 sharpen Medium (Crl+F4)

) . 3 sharpen Light (Shift+F4)
3. Move the mouse over one of these options to select whichever

enhancement level of the to apply, and release the mouse button.

4. Users can repeat application of this process several times if needed to further the enhancement or
contrast.
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hapter 8 — Scout Lines and MPR

Scout lines are used to determine the location of the images in one series compared to another
(saggital to axial, for example) for MR and CT. Scout lines can be used alone to reflect the position
on the axial or saggital images in relation to the Scout image, or it can be used in conjunction with
X-Ref to display the corresponding plane of interest in the series as compared to the Scout =
4
@/\

image. The following shows the use of Scout Lines as a stand alone option and with X-
Ref turned on.

Scout Lines

To use the Scout Lines feature, use the following steps. Any appropriate image can be selected as the
“scout.”

1. With multiple series on the screen, select the image that to be the scout by first clicking anywhere in
that image’s window. This becomes the active window, as shown by the darker blue color on the
window’s title bar. VSt i +1, 3 11730 SRFD T

2. Click the right mouse button 5.0 e Mo e
on format Images on the -
main menu bar (or the pop-
up menu), and then select
Scout Lines [Ctrl] + [S]
from the secondary menu.
Select Scout Lines.

3. Select another appropriate
window (series) on the
monitor. The pop-up menu
disappears. As the user
moves through the second
series of images, the scout
lines appear on your
selected scout image, as
shown in the following
figure.

4. For studies where the scout
is not broken out into a
separate series, users may
first want to use the Clone
this View feature to create a new series.
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MPRs

MPR is typically used with images from CTs or MRs to build a reconstruction of a specified plane.
MPR takes the data from multiple CT or MR images and builds the images into other planes
and provides another perspective for viewing the region of interest.

To launch a simple MPR, follow these steps:

1. Select and open in Stack view the series of images users wish to reconstruct. The
scout image also may prove useful to have open.

2. Select format Views and then MPR this View (M) from the main menu bar or from the
pop-up menu, or select [m] from the keyboard. A red hourglass shows on the screen while
the images are loaded into memory. The screen then divides
into two additional windows, and the two views to be
constructed appear in their own windows. An example of an
MPR screen is shown in the following figure, with the
reconstructions and their labels in the bottom two windows.

3. Move the cursor into the series being reconstructed; do not
press any of the mouse buttons. As the cursor moves over the
image, the other two planes corresponding to and intersecting
at the cursor location are dynamically built in their windows.

4. To adjust the window and level, magnification, and so on in the
reconstructed images, press and hold down the [Shift] key
while moving the cursor to those other windows. Then adjust
the window and level and other settings as users normally do.

HE

The orthogonal projection is built in its own window. Navigation around this image is performed by moving
the mouse around the original series and left-click and hold, and the other image depicts the new location.
The user can scroll through the reconstructed planes.

Standard measurements and markups can be done as well.
This MPR operation can take lots of memory. If the user gets a message saying that

the system does not have enough memory, try shutting down all other applications
and then try again.
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A clone is an exact duplicate of the selected series in stack mode. The clone is synchronized with the
selected series, but the window/leveling can be changed separately from the original series. This function is
helpful when the user wants to look at the series in different window/leveling settings.

Cloning a Series

To create a clone, follow these steps:
1. Select the patient and select the series to be cloned.

2. Click on Format Views drop-down menu and
Select Clone, or select Ctrl + C on the keyboard

For example the original series of the brain may have
the window/leveling set for brain, (image on the left)
while the window/ leveling setting for the clone (image
on the right) is set to bone. It allows side-by-side
comparisons of images in the same series.

The series are also synchronized, so that the same
image number is shown as the user scrolls through the
series.

Linking Multiple Series

Multiple series can be linked so they can be scrolled together. To link multiple series:
1. Select one of the series to link.

2. Next, select format Views from the main or pop-up menu,

and then select Link Views (I) from the pull-down menu.

The Link Views dialog box displays, as shown in the —Lirk By Relative.. _ _
following figure. & Frame Mumber | HHink Mulhl

" Puosition - :
T Unlink This | 0K,

INSTRUCTIOMNS:

. { 1. 'ou selected primary Yiew - it controls the rest.
Frame Number or by Position. Select the 2. Mow left click on one or more secondary iews.

button from the Link Views box. 3. Right click when done.

4. |If there is a series that should not be in the group, then
simply select the series to be unlinked and select
Unlirk Ths

5. The linked series can now be scrolled simultaneously by clicking on the original series chosen. All of
the series in the links are designated by the two chain links on the bottom left-hand corner of the
series’ window. The chain links on the original series are different from the others.
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* BRIT View - 31, w3 110 2/1 CT ABMOMEN C
Pk Lik... Pl St formsd Vewrs Jiwmak brages. Zooen Ok dl.,. Helo

6. Series also can be selected
individually to add to the link. Rather

2 N bt ek o o
3 R choh when dene.

than selecting e
the INSTRUCTIONS in the Link
Views box. This also works for
linking series between exams or in
different studies.

S TR T
Fm L —

To look at just the linked series (remove
other series from the screen), select format
Views from the main or pop-up menu and
then select Group Views from the drop-
down menu. The Group Views signifies that
this is a hotkey for the Group Views
function. To retrieve all the series, select
format Views>All Views (v) from this
menu.
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Chapter 10 — Annotating the Image

There are many different types of annotations that are available for the users to mark and note the relevant
areas in the region of interest. These could include measurements for distance, angles, drawing arrows or
freehand drawings, rectangles, circles, text notations, scoliosis measurements, and many others. The
markups and annotations are saved in the system as “Presentation States”.

Annotations and measurements can be completed for a variety of areas such as Angles or Lengths of the
image, region of interest measurements (ROI), freehand drawings, and different fonts can be selected as
desired. Annotations can also be turned on and off for the image.

Select the annotation desired, position the cursor, and perform the annotation or measurement.

This section covers how to create the markups and annotations.

Annotating the Image

Users can select the Annotate option under Utilities on the main menu _
bar or from the pop-up menu. The Annotate menu includes options for BEEEEE

making length or angle measurements, for inserting arrows, for Kopmages E?HK)
. ; ; 0
freenand drawing, and for using ellipse or rectangle Shapes. o i ket i
Annotations also include the capability for typing text on an image, and Pmatkups  (P)
for changing the size and format of the text used to label your drawings e (Shft4P)

and measurements.

Measuring an Angle

Angle measurements can be done by selecting Utilities, then

selecting Annotations, and selecting Angles. Position the

cursor over one area of the part to be measured, click the left

mouse button, drag the mouse down to the lower end of the

measurement, and release, then hold the left mouse button

down again and drag the mouse to the third end of the area to be measured for the angle.

1. Place the mouse cursor over the image of interest and press [F5]. This action immediately activates

the angle measurement mode, and the cursor icon becomes a

2. Press and hold down the left mouse button where the user wants the first line to begin on the image
(opposite end from where the angle is created).

3.  While continuing to hold down the left mouse button, drag the mouse to the other endpoint of the line
segment. As the mouse is dragged, a line is drawn.

4. Release the left mouse button when the line has the desired length
and direction. A label appears on the line to specify the length of the
line.

5. Move the cursor pointer (it is not necessary to hold the left mouse
button down) to the outer endpoint of the second line that will create
the angle. Click the left mouse button. The angle the user wants to
create and the length of the second line appear as labels on the
image.

6. Each successive measurement place the pointer and click the left
mouse button creates another measured line and angle.
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To turn off the Angles mode, press [F5] again or right click the mouse.

Measurements, annotations, or other information that is added to an image are not

Cloze
All

automatically saved to that image when the button is selected to exit the
exam. To save annotations select one of the File>Save or File>Print options from the
main menu or select one of the Save/Print options from the pop-up menu.

Measuring Distance

Measuring distance is one of the most commonly used measurement tool. Length measurements

can be done by selecting Utilities, then selecting Annotations, and selecting Length. Position the
cursor over one area of the part to be measured, click the left mouse button, drag the mouse down to
the lower end of the measurement, and release.

1. Place the mouse cursor over the image of interest and press [Shift]
+ [F5]. This action immediately activates the length measurement

mode, and the cursor icon becomes an .

2. To measure a distance on an image (for example, the length or width
of an object or body part), move the cursor arrow point to where the
user want the line to begin on the image, and press and hold down
the left mouse button.

3. While continuing to hold the left mouse button down, drag the mouse
to the other endpoint of the line segment. As the mouse is dragged,
a line is drawn.

4. Release the left mouse button when the line has the desired length
and direction. A label appears on the line to show the length of the line. The label information is taken
from the DICOM header data concerning the dimensions used for the image display.

5. As long as this measurement mode continues to be active, the user can repeat the process in steps 2
through 4 to draw additional measured lines.

6. Press the right mouse button once to turn off the Lengths mode. The pop-up menu WILL NOT
appear.

Measurements, annotations, or other information that is added to an image are not

Close
All

automatically saved to that image when the button is selected to exit the
exam. To save annotations select one of the File>Save or File>Print options from the
main menu or select one of the Save/Print options from the pop-up menu.
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Drawing an Arrow

To use the Arrows option and the Arrows to All option, use the following steps. The Arrows
option allows the user to draw an arrow that goes only with the image on which the user Sse———:
draws it. The Arrows to All option places the arrow(s) the user draw in exactly the same N
location on every image in the series. T2 TSE Sa - X
1. Click the right mouse button to access the pop-up menu,
and select Annotate>Arrows, or select Utilities, then the arvou can a1so be used
Annotate>Arrows from the main menu bar. The cursor Y

becomes an

2. Place the point of the arrow cursor at the exact location
where the user want the arrow to point on the image, click
and hold down the left mouse button, and move the mouse
away from the location.

3. Release the mouse and the arrow displays. Drawing longer
lines before releasing the mouse makes larger arrowheads.
Users can continue to draw more arrows until the right
mouse button is clicked.

Measurements, annotations, or other information that is added to an image are not

Cloze
All

automatically saved to that image when the button is selected to exit the
exam. To save annotations select one of the File>Save or File>Print options from the
main menu or select one of the Save/Print options from the pop-up menu.

Measuring Region of Interest (ROI)

In many cases the physician prefers not only a drawing around an area of interest but also
wants measurements for that area; these are called Region of Interest and includes the
drawings and various measurements. This section shows how to access various types of
Region of interest drawings. The Hounsfield Units average for a region is calculated using
the ROI tool, and indicates the density of the region of interest indicating air, fat, water,
tissue, or bone. Generally -1000 HU indicates air, -120 HU indicates fat, Zero (0) HU
indicates water, and ranges beginning with +40 HU indicating muscle on up to +3071 HU
indicating various densities of other tissue and bone.
1. Click the right mouse button to access the pop-up menu, and
select Annotate>Ell-meas only or Rect-meas only. Users also
can select these options from Utilities>Annotate on the main

menu bar. The cursor becomes an .

2. Place the point of the arrow cursor at the location where one
corner of the ellipse frame or of the rectangle is to be set, and hold
down the left mouse button.

3. Move the mouse in the direction toward the opposite corner, and
an ellipse or rectangle shows outlined on the screen. At the
desired size and shape, release the mouse button, the ellipse or
rectangle remains on the screen.

4. The ellipse or rectangle can now be used for measurement
purposes. Select the option Annotate>Lengths and the lines that
are drawn within the ellipse or rectangle appear with measurements.
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The options on the Annotate menu for Region of Interest include:
» Freehand ROI
» Ellipsis ROI
» Rectangle ROI

Measurements, annotations, or other information that is added to an image are not

Close
All

automatically saved to that image when the button is selected to exit the
exam. To save annotations select one of the File>Save or File>Print options from the main
menu or select one of the Save/Print options from the pop-up menu.

Calculating Statistics on Regions of Interest (ROI)

To use the Freehand ROI or Freehand ROI to All options, use the following steps. The only difference
between these two options is that Freehand ROl to All applies the
drawings to all images in a series.

1. Place the cursor over the image of interest and press the [Ctrl] +
[F6] keys to activate the Freehand ROI drawing mode. [Another
option is to click the right mouse button, select Annotate, and then
select Freehand ROI from the secondary menu.] This action
immediately activates the drawing mode, and the cursor becomes

a on the screen.

2. Hold down the left mouse button and draw carefully around the
region of interest (ROI). Release the mouse and a solid color or
grid fills the area. Users do not have to make a perfectly enclosed
drawing because the program connects the distance between the
two line endpoints and fills the grid between these points.

Reﬁ_

New

3. Click the left mouse button on the button. This action causes the grid to disappear. The
drawing becomes a dotted outline, and the program computes the following values for the area:

» nimgPix = the number of image pixels within the ROI.

» Mean = mean pixel gray-scale value (gray scale runs from 0 through 4091) or mean Hounsfield
Unit values on CTs (HU values range from -1000 to +1000).

» S.D. (standard deviation) = standard deviation of the gray-scale or HU values, as appropriate.
» Area = enclosed area in square centimeters or other appropriate dimension

» Perim (perimeter) = distance around the enclosed area in centimeters or other appropriate
dimension.

4. Perform the same steps to measure another ROI.
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Measurements, annotations, or other information that is added to an image are not

Close
All

automatically saved to that image when the button is selected to exit the
exam. To save annotations select one of the File>Save or File>Print options from the
main menu or select one of the Save/Print options from the pop-up menu.

Ellipse and Rectangle Drawing Options

To use the Ellipse, Ellipse ROI, and Ellipse to All options, use the following steps. The Ellipse option
simply draws an ellipse, but the other two options draw an ellipse and then calculate the five measurements
described above, with the Ellipse to All option applying the same ellipse to all images in the series:

1.

Place the cursor over the image of interest and press the [F9] key to activate the Ellipse drawing

mode. [Another option is to click on the right mouse button, select Annotate, and then select Ellipse

from the secondary menu.] This action immediately activates the drawing mode, and the cursor
-

- N

becomes an on the screen. i N

/ :
Move the cursor to the starting point, then press and hold down the left i A
mouse button. Move the cursor diagonally. The mouse can be moved ;| "< o
in any direction to make an ellipse, which appears similar to the figure — — T ——T—.. =t
shown here:

Release the mouse button when the ellipse is properly sized. A white ellipse will remain on the
screen. When the user presses the Re New button, the ellipse becomes a dotted outline.

If the user selects the Ellipse ROI option or the Ellipse to All option to draw an ellipse, the ellipse
will be filled with a solid color. When the user presses Re New, the ellipse will become a dotted
outline and will have the calculations described above (for Freehand ROIl). The Ellipse to All option
does the same thing as Ellipse ROI and calculates results for each image in the series.

Measurements, annotations, or other information that is added to an image are not

Close
All

automatically saved to that image when the button is selected to exit the
exam. To save annotations select one of the File>Save or File>Print options from the main
menu or select one of the Save/Print options from the pop-up menu.

To use the Rectangle, Rect ROI, and Rect to All options, perform the following steps. The Rectangle
option simply draws a rectangle, but the other two options draw a rectangle and then calculate the following,
with the Rect to All option applying the rectangle to all images in the series:

1.

Place the cursor over the image of interest and press the [F10] key to activate the Rectangle
drawing mode. [Another option is to click the right mouse button, select Annotate, and then select
Rectangle from the secondary menu.] This action immediately activates the drawing mode, and the

cursor becomes an on the screen. T T T T T T T -

[
Press and hold down the left mouse button and move the cursor diagonally |
across the screen. The mouse can be moved in any direction to make a :
rectangle. !

|
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]

3. Release the mouse button when the rectangle is properly sized. A white rectangle will remain on the

On CT images, the application calculates and displays the Hounsfield Unit
value for the pixel below the tip of the cursor. The display is in the upper

Fle.ﬁ_

New

screen. When the

button is selected, the rectangle becomes a dotted outline.

If the user selects the Rect ROI option or the Rect to All option to draw a rectangle, the rectangle will
be filled with a solid color. Press Re New, the rectangle will become a dotted outline and will have
the calculations described for Freehand ROIl. The Rect to All option does the same thing and

applies the results to each image in the series.

right corner of the Image Viewing screen, as shown in the following figure.

Wi 400 L: 40 |HU:S1

Measurements, annotations, or other information that is added to an image are not

Close
automatically saved to that image when the _2!

button is selected to exit the

exam. To save annotations select one of the File>Save or File>Print options from the main
menu or select one of the Save/Print options from the pop-up menu.

Freehand Drawing

Many times the physicians prefer freehand drawing around an area of interest, or having an arrow point to a

specific target, or drawing a box around the area.

freehand drawings.

To use the Freehand drawing mode:

1.

Place the cursor over the image of interest and right-click and
select Annotate and then select Freehand. This action
immediately activates the drawing mode, and the cursor becomes

a on the screen.

To draw a line segment, move the pencil cursor to the desired first
endpoint to begin, and press and hold down the left mouse button.

While continuing to hold down the left mouse button, drag the
mouse (using curves or straight lines) to the point on the image
where the second endpoint of the line segment is to be placed. As
the mouse is dragged, a line will be drawn. Note that the program
does not force a straight line. Wherever the cursor is moved while

holding down the left mouse button, the line is drawn on the screen.

This section shows how to access various types of

Release the left mouse button when the line has the desired length and orientation. As long as the
drawing mode continues to be active, each time the left mouse button is held and moved, an

additional line is drawn.

To turn off the drawing mode, click the right-mouse button once; the pop-up menu does not appear.

44

E EW '! BRIT View User Manual



Chapter 10 — Annotating the Images

Measurements, annotations, or other information that is added to an image are not

automatically saved to that image when the
exam. To save annotations select one of the FilesSave or File>Print options from
the main menu or select one of the Save/Print options from the pop-up menu.

Close
All

Changing Fonts for Labels and Text

The options on the Annotate drop-down menu that are related to text use or text sizing and formatting

button is selected to exit the

include: Font PIx
> Font - meas Font: Font style
> Text |Fegular oK. |
» Text to All il Black e Cancel

> Font - text.
To use the Font — meas option, use these steps:
1. Place the mouse cursor over the image of interest and

() Lial Namow

() Liial Founded MT Boh

€} Aiial Unicode M3

€} Baskervile 0l Face
Batang M

Ealdltalic

Sanple

AaBbYyZz

Scripl:

1W’estem j

select Font-meas from the Annotate pop-up menu. The
Font dialog box displays, as shown here:

2. The Font dialog box shows the default settings for Font,
Font style, and Size. The user can change these settings
by selecting from the three appropriate list boxes. The
Sample field shows the user the selection that appear on

the image(s). After the changes are made, press

, the font style and size that the measurements exhibit change accordingly.

The only difference between these two options is that the Text option is applied only to the image, whereas
the Text to All option is applied to all images in the series. To use the Text option or the Text to All option,
use the following steps.

1. Select Annotate>Text or Annotate>Text to All from Utilities on the main menu or from the pop-up
menu. The cursor becomes a vertical bar.

Move the cursor to where the beginning area to type the text, and press the left mouse button once.

Begin typing. To type more text in another location on the image, just place the cursor at the desired
location, press the left mouse button again, and start typing.

Measurements, annotations, or other information that is added to an image are not

Cloze
All

automatically saved to that image when the button is selected to exit the
exam. To save annotations select one of the File>Save or File>Print options from the
main menu or select one of the Save/Print options from the pop-up menu.

To use the Font - text option for changing the font style or size for the text as typed, use the following steps:
1. Select Annotate>Font - Text from Utilities on the main menu or from the pop-up menu.
2. The Font dialog box displays, as shown in the previous figure.

The Font dialog box shows the default settings for Font, Font style, and Size. The settings can be
changed by selecting from the three appropriate list boxes. The Sample field shows how the

selection appears on the image(s). After making the changes click on the button, the font

style and size change accordingly.
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Sticky Notes

Sticky Notes are a method of typing information on an electronic note that can be saved to the server and
made available to other DICOM Workstations. These notes are stored in the DICOM Key Object Notes. To

create a sticky note, use the following steps:

1. Under Utilities on the main menu bar, select Key
Image Make]. The Mark as Key Image dialog box
displays, as shown in the following figure:

2. On the text field labeled From, click the small down
arrow and select the position from the choices of:

» Radiologist (default),
» ER Physician,
» Attending physician,
» Referring physician
» Technologist.

3. Under Reason code, the choices are:

Of Interest (default),

For Referring Provider,

For Surgery,

For Teaching,

For Conference,

For Therapy,

For Patient,

For Peer Review,

Date: 06/15/2004

For Research,

YV V. V V V V V V V

Rejected for Quality Reason
Quality Issue.

4. Move the cursor into the wind and

type a short note. Select 2 to
place the yellow note in the upper left-
hand corner of the current image, as
shown in the following example:

5. When closing the image or exam, will see
the following message appears:

Key Image and/or Annotations [g|

You have marked one or more images.

Do you want tc save the marking?

6. Select

Yo Mo

Mark as Key Image

Reason code: | Of Interest j
Optional - Add a short "Sticky not2"

Cancel |

for Entire Series ‘

| Reason: For Referring Providor

| Your comments show up here.

2| to save this Sticky Note on the server and

therefore make it available to other DICOM Viewers that
support Key Objects.
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The BRIT View application can be set-up to support IHE Presentation States and Key Objects or “Sticky
Notes.” This involves adding an application to the workstation to support a DICOM store back to an archive.
Regardless if any annotations are made, a confirmation is requested when closing the exam if the
annotations are to be saved. |If the answer is “Yes,” then the annotations are stored to the archive. Sticky
Notes are always stored.

Presentation States

Using Presentation States (PS) is a method of saving the exact look of an image, including window and level
and all annotations and notes, so that another user on a DICOM workstation (that also supports Presentation
States) can view the image with the same look (annotations, notes, and window

and Ievel). Key Image and/or Annotations |gi

Creation of Presentation States: Annotations created with the BRIT View will be ¥ou have marked ane or mare images.
saved as Presentation States on the DICOM Server (this requires an additional Do you wank te save the marking?
application and integration). When closing an exam, a box appears asking if the

annotations are to be saved. All annotations that are present are saved when i (IS

clicking on the i I button.

Displaying Presentation States: If an exam is downloaded and has Presentation States (this does not
require anything additional), then the PS button on the Toolbar is activated. Selecting this button displays all
the images with all Presentation States in a montage.
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If the hospital has the capability to print, users can select the patient reports that

need to be printed.

If a report is available, then it is available from both the Roentgen RIS
screen and also from within BRIT View. Select the Reports button on
the right-hand Toolbar and the report is displayed in a Notepad
window. From here, the report can be printed, edited, and saved

under another name.

Printing a Report

This option is present under both the File and Print
main menu options and from the pop-up menu under
Save/Print. [The term WYSIWYG stands for What
You See Is What You Get.] To print reports with
images:

1. First, set up the images in the viewing area as
they are to be printed.

2. Select File from the main menu bar.

3. On the drop-down menu, select Print Report
+ WYSIWYG. The generic Windows Print
dialog box displays, as shown in the following
figure.

4. Select the printer to the destination to send
the report and on-screen image(s), select the
number of copies, and then press OK. The
report and images are then printed.

Chapter 11 — Printing, Saving, Sending

Chapter 11 — Printing, Saving, Sending

Print
i~ Printer
M arne:
Statuz:  Ready
Type: HF Color Lagerlet B500PCLE
“Where:  hpoolorLaseret5500
Comment: ™ Piint to file
— Print range - ~ Copies -
Al Murmber of copies: 1 E:
€ Pages from |1 ta: |1 ] E
Ok | Cancel

View, Create, and Select Reports

Reports also are available under the File option on the main menu (as follows) or from Key/Mark/Report item

on the pop-up menu.

» File>Reports View - displays report information the same as the Reports button on the Toolbar (in a

Notepad dialog box).

> File>sReports Create - if activated on the menu, this feature initializes report creation, for example,

starting dictation equipment.

» FilesReports Select - if structured reports exist for the study, this feature displays the structured

report.

“V' |ew BRIT View User Manual
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Adding a Report

Adding a report is done in the RIS only. Use the Add button on the Manage Report Panel to
type a report in the Interpretation Text area. Any text already present is saved as a separate
report when the selects the Add button to input new text. The Cancel button takes the user to
the Patient Panel or cancels the current Add or Edit. After enters the report, press the
Prelim or Sign button to save the information at the level desired. At this time the Edit and C
Delete buttons become active.

Editing a Report

Editing a report is done in the RIS only. Any radiologist may edit a report. Use the Edit button to make
changes in the Interpretation Text field, which is grayed out and inactive when the Manage Report Panel
first displays. The original text remains until it is changed. The Draft, Prelim, Sign, and Cancel buttons do
not activate unless changes are made. To cancel and not make any changes, use the Navigation Compass to
return to the Patient Panel.

Deleting a Report

Editing a report is done in the RIS only.  The Delete button

Question

becomes active only when a report is selected. Users can delete Are 40U SUTe You want to delete the selected report?
another radiologist’s reports. When selecting a report, press Delete, :
and the following message displays. ves || no |

To continue with the deletion, select

The report is deleted and the Patient Panel appears. Otherwise, select

Printing Images

The BRIT View application supports printing to any printer defined to the
PC, as well as DICOM printing. DICOM printing requires additional
integration. The quality of the paper print will depend on your printer. To
print a single paper image, use the following instructions:

1. First, set up the format and annotate the image(s), if necessary.

2. From Print or File on the main menu, select Print [,
WYSIWYG Paper [The term WYSIWYG stands
for What You See Is What You Get] A — _
standard Windows Print dialog box displays as Nare. [ EIEEMGISSESEEEY «|  Properies._|

Frirter

Shown here Statuz: Ready
Type: HF Color Lazerlet 5500 PCLE
3. Choose the printer, paper format, and number of Where:  hpcolorLaserlet5500
copies. Comment: [~ Prirt ta fil
. Prirt range Copies
4. ;erl]?g: : 1l to send the image to the & Al e e
i .
o [l oE
Ok | Cancel |
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To print an entire series in a selection of formats, use these instructions:

1. First, display just a single series on the monitor. Select Film Printer to Use  [X]

2. Select the Print option on the main menu bar. Selected Printer

3. Click on Select Printer from the drop-down menu. The following Select | [ERIT Test1Fim
Film Printer to Use dialog box displays. This dialog also allows paper

printer access. &ll Prinlers [select one)
4. From the dialog box, select Plain Paper Printer. BRIT Test1 Paper
Fuiji Printer

Next, select the matrix desired to use from Print on the main menu or Plain Paper Printer
from Save/Print>Print General on the pop-up menu. All options begin
with the word Marked, because the next step is to mark those to print.

Cancel

6. Once the format has been selected, a screen is shown with all the
images in that series, along with a box (Image Print) used to select
images to print, as shown in the following figure:

7. The options in the Image Print box can be
used to select all or no images quickly;
otherwise, just select the individual images
by clicking anywhere inside them.

Clicking on an image toggles that image
between selection and de-selection.

Selected images have a green in the upper
left hand corner.

Images not selected have a red .

In the example figure, the top two rows of
images are marked to print and the bottom to
rows are not selected.

i DOME
8. Once all images are properly marked, select [ from the Image Print box. If any of the
Fle_ﬁ
images turn black during this process, use the Ne¥ | button on the Toolbar to repaint the screen.

The Print General Option

To use the Print General option, use these steps:
1. Select the option Print from the main menu or Print General under File on the

This image only
This img, true sze

main menu or under Save/Print on the pop-up menu. After selecting Print Marked, £ byl
General, the following list displays. Marked, 1 by 2

2. Select a format from the list. The images will be Marked, 2 by 2
displayed in the chosen format, along with the SIS Marked, 2 by 3
Mark Images box shown here: &';:Qsmea”fgs thir;dsa:;es Marked, 3 by 3
Marked, 3 by ¢

Unrmark, b ark Marked, 4 by 5

ALLSeries | ALLSeries

Marked, all on one
DOME Ahort Select printer
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3.

..........................

click
displays about how the images were marked.

To continue with the irintini, select L
dialog, or select to cancel and return to the image marking

screen and the Mark Images box.

Mark the images to be printed (they will have a . on the image), and

The following Ready to Print confirmation message

Ready to Print

Ready ko print 1 filmis)
it Ly Z lurimal

on the Ready to Print Is this OK?

Yes Mo

consisting af 3 images

on the Ready to

After making the final choices and selecting

Print dialog, the generic Print box displays to allow the printer to be selected, and the printing

function completed.
Print

Select the print options, and
Printer

click on the L& d button. [NV 5 0JEC T HP Color Laseret 5500 PCL R IR
Status: Feady
Type: HPF Color Lazer)et 5500 PCLE
“Where:  hpeolorLaser) etB500
Comment: ™ Piint to file
Print range Copies
4l Murnber of copies: 1 3:
o CRGELE

(] 4 | Cancel

Saving Images

Images can be annotated, windowed and leveled, or otherwise manipulated and then saved as DICOM
presentation states. An optional module allows these presentation states to be stored back on the server so
they can be downloaded by other users.

Saving Images as DICOM

Images can be annotated, windowed and leveled, or otherwise manipulated and then saved as DICOM
presentation states. An optional module allows these presentation states to be stored back on the server so
they can be downloaded by other users. To save an
image (or screen of images) as a DICOM image:

1.

Start by setting up the screen just as it is to
appear.

Next, from the File option on the main menu bar,
select Save WYSIWGY Dicom. The following
Save As dialog box displays:

The default folder for saving the images is called
DICOMImages. This default folder can be

PIX
| = @ ef B

|E2#37-59-26
[

Save fis

Save in: |_) DICOMImages

|E00xR0010
=+
|E63-38-44
[C472-54-3171
ii;j4?6-36-1450

()

File name:

)
[GRABO0<AOTI0_001

VR E e [ icom Files [ dcm)
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selected another folder and the user must enter a name for the screen that is being saved. If users do
not want to enter a name, the default name that the program enters automatically (see name above in
the File name field) is entered.

4. Make sure the Save as type field says Dicom Files (*.dcm).

5. Select the Sk

button to save the DICOM image.

Saving Images as .JPG

Images can be annotated, windowed and leveled, formatted, and saved to the operating system for
incorporation into PowerPoint presentations or other documents. To save an image as a JPEG file for this
type of purpose, use the following steps:

1. Start by setting up the screen as it is to appear.

2. Next, from the File option on the main menu bar, select Save WYSIWGY Jpeg. The following Save
As dialog box displays. o E%

3. The default folder for saving the images is called | savein | Joegimages =l « @ cf &
Jpeglmages. Select this default folder or select another
folder and enter a name for the screen. If users do not want
to enter a name, use the default name that the program
enters automatically (see name above in the File name

field). . |
4. Make sure the Save as type field says Raw Jpeg Files |~ /BN [
(*'i pg) . Save aslype: | Raw Jpeg Files [*jpgl j &
Save .
5. Select the button to save the JPEG image.

Sending Images

There are several options for sending images to other locations. To e-mail images to a r

user without a DICOM workstation, the user can use the JPEG tool first to create and save | T T
the necessary images. The user can save the images in the JPEG format to a selected | thisieries | thisheries
spot in your directory. Then, use the attachment feature of your e-mail application to | Unmak | Maik
attach the JPEG file and send it. praaks ] nibivies

o

DOME Abort

|

|
1. To send the images back to a DICOM server with presentation states, use the |
Save WYSIWYG Dicom option under File on the BRIT View main menu bar.
This saves the image(s) as DICOM format.

2. Annotate or set up the screen as desired.

Two other methods involve using the options Images to Send and Images to CD, which can be
accessed from File on the main menu or from Save/Print on the pop-up menu.

4. Images to Send allows selection of images to transfer to a DICOM server via SendCommon (if
configured at the installation). When selecting the Images to Send option, a small Mark Images
dialog box displays, as follows:

5. Click on L il and an Images Marked to Send dialog displays to verify that what is marked is
really the images to send.
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Click Li
application

1 and the images are sent to one or both locations enabled in the SendCommon

If a Rimage high-volume CD burning is available on the system (attached to the
Radiology Workbench for Windows, please refer to the separate Rimage and BRIT
Systems documentation regarding how to use the Rimage CD burner.

Using Send Common

The ability to send images to another location using BRIT’s SendCommon application requires system set up

by a System Administrator prior to your use.

The user can designate two active destinations. Many

destinations can be established and available, but only two can be active at any one time. The user can send
DICOM images to both active destinations or the user can select only a single destination. Assuming that the
SendCommon destinations have been set up and tested, the following steps guide the user through the use
of this feature.

1.

10.

Format on screen the images that to send or, if an entire series is to be sent, format a montage of
part of that series.

Select File>Images to Send from the main menu.

The Mark Images dialog box displays along with the images, which now have a in a small box

in the upper right-hand corner of each image. The . means they are still unselected.

Click the left mouse button once anywhere on an individual image that to mark, or select Mark this
Series or Mark ALL Series from the Mark Images menu.

Images Marked to Send |z

After the selections are made a appears on the image.

There are 1 series with a ktotal of 33 images
Z images are marked for a sending,

Click on the button. If Abort is selected, the action is
stopped without out sending any images.

You will send the images using “SendCommon”
to the selected destination,

Ic thic QK7
Another dialog box labeled Images Marked to Send displays, as
shown in the following figure:

Once the marked images are detected in the outbound image
directory (the system polls the directory every 20 seconds looking for .dcm files to send), the system
automatically sends the images to the currently selected destination(s) as set up within the BRIT
SendCommon application. As noted earlier, the destination must be specified beforehand by the
System Administrator to establish these destinations. x|
The destinations that have been selected within the SendCommon  Fatient: 01218215 REG. WE Spots Bone

Examn: .
Image: number 0, 0 pixels
hzpoolidatah4Dicom ANCEY.1.2.840.113797.10645261!

fes Mo |

application at the time the button is pressed on the

YOU WILL HAVE OPPORTURITIES TO TRY AGAIM

Images Marked to Send box are the locations to which the images
are sent.

If the sending of images is completely successful, no messages of
any type are sent. If there are any errors during sending of the
images, the following error message box appears:

AFTER | HAVE SENT &LL THE IMAGES | CAN - For
niow, | will move the image out of the way so | can
proceed... unless you say different

Eror Meszage =
Can't use context 1.2.840.10008.5.1.4.1.1.88.59. It was
not negotiated.

| will choose "Try Later' in |2 zeconds

Deletefits | Mave fie |
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11. Users must now choose from three buttons at the bottom of the message box. Press the L
-DeleteFile

button to attempt the transfer again, press to remove the file from the outbound image
queue, or press to move the file into a “bad” directory under the DICOM destination

folder.
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Chapter 12 — Teaching Files

The ability to create teaching files is a useful function in every hospital environment. It helps
the new Residents and Interns to learn about standard diagnoses as well as those
“interesting” and “unusual” cases that do not occur as frequently, and provides an easy and
accessible method to store and retrieve them. Users can select individual images or series
of images that can be used for these Teaching Files.

There are a variety of theories and studies regarding how these teaching files should be
arranged; and the most effective means is to create Teaching Folders to help keep these studies efficiently
organized. These could be designated by body part, modality, diagnosis, or any other description that would
help identify the types of studies in the folder. The studies are then placed into the appropriate Teaching
Folder.

This application allows the user to set up independent work lists and a monitor can be designated to be used
to display the teaching folders only.

Teaching files can be created from any clinical or research DICOM images that can be read into the BRIT
View. The image- and series-specific parameters that are produced by the original modality are retained. All
of the common patient identification information is replaced by default values. Because the files use standard
DICOM, they can be stored on a central DICOM archive and can be used by anyone with a DICOM viewer
and proper authority. Depending on the archive, they also can be retrieved using web viewers.

The files do not depend on the existence of any underlying database manager. They do contain information
to make finding, sorting, and viewing the appropriate images easier. Special “patient ID’s” can be used to
designate department+section+radiologist+"patient” for easy selection from a list of patients.

BRIT Systems retain all of the original raw image data, and the associated information needed to show the
images properly as teaching files. The images (and studies/series) generally is displayed exactly as if the
“patient/study/series” was obtained directly from the image modality. A few relationships may be lost because
only some of the images from the original studies/series are retained, and a few others because the created
teaching “studies/series” are derived from multiple clinical studies/series. With very little effort, users are able
to select partial series/studies that “play” as naturally as the original full series/studies on a DICOM viewer,
and combine images/series/studies from different real-world patients into a new “teaching patient.”

Organization of the Teaching Files

A teaching file can be a single patient's exam/image, multiple exams/images for the same patient, or a
mixture of exams and images from multiple patients. The user

determines how the files are organized. g(@\

Each patient can have an unlimited number of studies, which can - g/jf(/\‘ Study
consist of multiple series that contain various images. \& /;/

For example, the Study would be compared to a book, the Series . .
would be a chapter in the book, and the Images would be a page = E Sepies
the book. - —_—

Generally each Study has a corresponding Report that the DAFCE |
Radiologist has dictated and approved that relate the findings from the _ _'li-l_' H 9
images in the exam. [ s

All of these components are matched if the Accession number is the same in all components.
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The following are some performance suggestions for planning the layout of a teaching file.

>

>
>

It may be desirable to have series/studies/patients with a large number of images so that the user
seldom has to make menu selections. However, most viewers’ performance drops when the number
of images in a series is too large. Also, if a “patient” illustrates only a few didactic points, that patient
might be more useful in multiple presentations.

Limit the size of a series to no larger than a fairly large clinical series from the series’ modality.

If the target viewer does not easily handle series one-at-a-time or a-fewat- a-time, limit the number of
series in a study.

Try to make each study illustrate only one or two points.

Use a “patient” to illustrate a set of related points.

Sample Teaching File Organization

This sample is shown as an intended Teaching File containing studies to present something related to lung
issues to the new residents.

The selected studies reflect early, middle, and late findings. The early time period has a couple of natural
studies, each with two to three series. Middle has about four studies, each with two to five series, and late has
about ten studies. In the hospital, the teaching file patients are identified specifically, such as last names
beginning with an “X” and these patient’s whose ID begins with XR are certainly their corresponding Patient
ID and make the Accession Number Correspond to the Patient ID.

PATIENT ID XRLUNGS1000

PATIENT NAME XBURNS, XGEORGE

ACCESSION NUMBER XRLUNGS1000

STUDY DESCRIPTIONS OF Early, Middle, Late1, or Late2, or Final, such as:

XRLUNGS1000Early
XRLUNGS1000Middle
XRLUNGS1000Late1
XRLUNGS1000Late2
XRLUNGS1000Final

The first study gets a short “study description” to show in lists such as Early, Middle, Late1, Late2, or Final.

2 CT series, each with selected images from a different CT exam of the same patient.

1 CR series, with images from a different exam for the same patient.

2 MRI series, selected images from different sequences in one MRI exam.

The second study gets another Accession number such as XRLUNGS1001 and another short “study
description” such as Early, Middle, Late1, Late2, or Final.

2 CT series, exams from different patients

1 CR series, exams from different patients

2 MRI series, short sequences of exams, different patients ... and so forth
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Creating a Teaching File

After the naming convention is determined, the next step is to select the images from the various studies to
place in the teaching files. The basic steps are as follows:

1. Select the first patient/exam from to be used for the teaching file..

2. Once the exam is opened, click on FilesMake Teaching B RaI=A
File. The Teaching Files Info dialog box displays, as
shown in the following figure:

[*] Indic:ates required value, rest will be generated.

[*] Patient Mame ||

3. Type in the required Patient Name, Patient ID, and Your

teach ID. i PatientID |
4. If desired, add the Patient DOB, Study Description, (9¥ourtoach D |
Accession Number, and a Referring Physician. Fill in the Paiert DOB |

accession number if to allow access to a report. Due to
patient confidentiality, a new report needs to be dictated and
assigned this Accession number for the teaching files. How
this “teaching” report is stored on the RIS needs to be Referiing Phys. | TeachDoc
determined with the IS department.

p Cancel | Help | ok |

Study Desc. |

Accession number |

5. When the information is completed on the Teaching Files

Info dialog, click on Li:

Mark Images

6. When ] is selected on the Teaching Files Info dialog, the study | |,k o
images remain and the following small dialog displays. T

or to cancel the creation of a teaching file at this time select

7. The Mark Images dialog allows the user to mark or unmark all series that are Lrriark b ark.
open. To select an individual image for inclusion in the teaching file, move the | ALLSeries | ALLSeries

cursor over the image and click once on the image with the left mouse button.
h DONE | Abart \
A small box with a appears on the image. To de-select an image, click on

it again with the left mouse button. A . indicates the image is deselected.

Ahbaort
8. Users can select the button on the Mark Images box at any time, and none of the images
are saved, but the images will remain in BRIT View. : —
When all deswed images are marked from this patient, | i BEE SRS El ]

There are 1 series with a total cf 4 images
click on the Mark Images dialog. The 4 images are marked for a teaching File,

following dlalog displays to verify the actions:

These will be converted o "Teazhing File” images.
You will send the images using “3endCommon’
ko the selecked destination,

9. If is selected, the images are saved

under the created patient name. If = is
selected at this point, none of the images are saved,
but the images remain in BRIT View.

Is this Ok?

Yes W

10. Close this exam and then select the next patient who
has images to add into this teaching file.
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Protecting Patient Confidentiality

One of the goals of the teaching file creation method is to require as little labor as possible and still retain a
reasonably high level of patient confidentiality. In order to guard patient confidentiality, it is necessary to
remove most of the patient-related DICOM attributes, and replace most of the remainder. It is also necessary
to “break” DICOM cross-references to other studies/series, and to disguise exam times and dates. Most of
the valuable information can be automatically altered and still retain its teaching value, without requiring a lot
of user-entered information.

Additional steps need to be taken in some cases. For instance, some “native DICOM” images have patient
information “burned-in” to the image itself, as in the case of some CR and many ultrasound images. All
digitized film and most “frame-grab” secondary capture images contain patient information. These images
may need to have regions “blacked-out” before including them in teaching files. In other unusual instances,
patient information may be buried within DICOM comment fields or within attributes intended for other things.

BRIT’s approach is to retain as much of the valuable information as possible without requiring the user to
“scrubb” each bit of information within each DICOM attribute. This is adequate for the great majority of
situations, except for “burned-in” images.

BRIT has examined a fair number of DICOM images from different institutions and manufacturers, and
believe that the following measures provide adequate confidentiality for the great majority of medical teaching
applications. Additional security would require great effort on the part of the person preparing the teaching
file. Nevertheless, we recommend that distribution of and access to the teaching files is limited.

Note that “data mining” for the purpose of research is a completely different sort of application. The user
operates under protocols through a database manager, which has access to all of the original patient
information. But the user usually sees only summary information about statistical relationships, and there are
strict security and user audit procedures.
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There are many different ways that the studies can be set up for viewing the series and images. These
include the format that is used, window and leveling preferences, rotation preferences and several other
variables. These settings are called “Hanging Protocols” and can be ‘

defined based on the modality on which the study is performed as well
as the body part. Different modalities and body parts can be set up with
specific hanging protocols.

This ability for users to create and use hanging protocols is one of the
most important and time-saving features in BRIT Vision. Since users
can establish preferred settings and hanging arrangements for all the
different modalities and body parts that are automatically applied when
an exam is opened, the Radiologist doesn’t waste time selecting the
format, window/leveling settings, and other variables that they want set
to their personal preferences. In all subsequent sessions, any exams that match the pre-defined protocol
descriptions are displayed in the manner preferred. Multiple protocols can be defined and users can select
any of those as the default, or dynamically as desired.

Hanging protocols are supported for exams by exam type, body region, and modality for each user. These
hanging protocol tools can be used to rearrange an exam’s images and then save the settings under a
specific name just for that modality or exam type. The saved view can be quickly applied by clicking on the
name in the list that displays.

Users can establish, name, and save the preferred settings and hanging arrangements based on study
descriptions, body parts, and modalities. Default settings can be accepted or changed for window and level,
flip/rotate, and magnification. In subsequent image viewing sessions, the exams that match one of the
predefined protocols is displayed in the preferred manner. Users can also create alternative protocols and
change to one or more of these different protocols during viewing.

The hanging protocols feature also allows users to open two studies (to perform a comparison) and create a
hanging protocol for the two studies together (the PRIMARY Study and the COMPARE With study). As with
a single study, users can choose to save the hanging protocol by study description, body part, or modality,
and accept default settings or change settings for window and level, flip/rotate, and magnify for each of the
two studies.

This section identifies the components that can be defined, the steps to set up hanging protocols, and how to
create sequential hanging protocols.

In order for hanging protocols to work properly, it is extremely important that

information about study descriptions, modality nhames/types, and body parts be

entered into the computer system completely, correctly, and consistently. This

information comes from the DICOM header as studies are matched to the saved

hanging protocols; therefore, the information entered for those fields must be consistent at
all times.
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To access the options for hanging protocols, select format Views from either
the main menu bar or the pop-up menu. The following menu displays. The
four options related to hanging protocols is shown below:.
» Hang Monitors — Allows users to select the studies or views to hang
on your
» monitor(s).
> Select Hanging — Allows users to select a protocol for hanging the
currently displayed study (or studies).
> Save Hanging — Allows users to name, describe, and save a hanging
protocol to the local PC and to the server.
» Delete Hanging — Allows users to delete a protocol from a specific list
of protocols.

Users also can use the two bottom buttons on the Toolbar to access the

b, i
B A=

a5

Hang Monitors
of images.

dialog or to select a protocol during the viewing

Cne Yiews Only
Al Wiews

M=xt View

M=t Exam)study
Tie - Stack Al

A1 Wiews [ Tmos

MPR. this Wigw
Cone this Wiew
Liqk Vimwes
Group Views
Hang Maonitars
Select Hanging

Save Hanging
D=lete Hanging

Cose Al

(¥
(¥

(down)
()

(T3
Ghrl-A)

(M)
i
L
fia)

{H
(ke H)
(Shft+H)

(Esc)

Screen Settings that can be Set in Hanging

Protocols

Hanging protocols are intended to save time by letting pre-setting many variables of the BRIT View
application. The images that are viewed can be arranged in almost an endless number of ways using the
various tools and settings. The variables that are pre-set and saved in the hanging protocols include the

following:
» Number of monitors
Format of multiple images (or series) on the screen
Zoom (magnification) or Fit
Window and level
Rotation and Flipping

Reverse Contrast

Y V V VYV VY

Positioning of series.
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Creating Hanging Protocols

Use the following steps to create and save a hanging protocol that applies to a single study.
1. Open the study for which to create a hanging protocol.
2. Select format Views and then select the option Hang Monitors [H].

3. The Select studies or views to hang dialog box
displays, as shown in the following figures: This
dialog allows the user to assign the various views Dispiay Manior el
(or series) to one monitor as shown to the right, or
across two monitors as shown below: e

Stely 1: CT., 19980603, BRAIMN
51, View 1: SCOUT
S 1. View 2: PRE CONTRAST

Select the studies or views to hang - select monitor(s) first

51, View 3: POSTS CONTRAST
Left Monitor Right hionitor Cancel
Push Me - To use both Manitors

for a single Study or View Clear Monitars
Sty 10, .. -
51, Wiew 10
51 Wiew 2
51, Wiew 3
S, View 4
51 View 5
51, View B:
51 Wiew 7
51, View 8
51, Wiew 9
51 Wiew 10
51 View 11
ST Wiew 12
EERY L ﬂ

4. |If only a single monitor is available, the Display Monitor box appears to be selected. Move the
cursor over the desired view for this monitor and click the left mouse button once. The view name
moves from the list to inside the Display Monitor box.

When selecting views to be placed on the monitor, the system displays them in the
order selected, left to right across the top and then down the screen. So, if a
specific type of view is desired, in the upper left-hand corner of the monitor, select
that view first in order for the view to be placed there in the hanging protocol. This
also applies to a two-monitor system as views are selected for each monitor.

5. If a two-monitor system is available, after all the desired views have been moved to the Left Monitor
box, click the mouse on the Right Monitor box and then move any additional views to that monitor.

6. Cancel can be selected at any time to close the dialog box or click on Clear Monitors to reset the
names on the list and on the buttons as they were before assigning them to monitors.

7. After the desired views are assigned, click on Lk
The dialog box disappears and the views display across the monitors as they are set up.

Continue designing the hanging protocol by again selecting format Views. Select the option Save
Hanging.

10. A small dialog box entitled Login for Local Operation displays, along with the main dialog box
Arrangement as Hanging Protocol. Enter the User Name in the small dialog box and

21 to proceed.
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11.

12.

13.

14.

If a single study is open, the Save Arrangement as Hanging Protocol dialog box opens; it is

specific for only one study being viewed. If this box were
requested for saving a comparison set of studies, there
would be additional prompts below the PRIMARY Study
in an area labeled COMPARE With. [The situation of
saving hanging protocols for comparison studies is
covered in the next subsection.] Users always see the
second dialog box if two monitors on the system.

The PROTOCOL NAME field displays with the
abbreviation of the modality type already present (CT_in
the figure above). The remainder of the name must be
provided, which should be a name that users can
recognize for the type of study being displayed and
saved.

Under PRIMARY STUDY are seven items that can be
left as they are or set as desired. The Study Description
field initially has the radio button beside it selected and

Save Arrangement as Hanging Protocol gj

PROTOCOL NAME | CT_ |

Select by

FRIMARY Study

Study Description %

BRAIN

Body Pait

Modaly

CT

Usze defaults far: W Window/_evel ¥ Flip/Rotate ™ Magnification

Alsouss: [ Series descriptions

Cancel

Save

contains the words that were entered at the time of the order as the study description, and saved as
part of the DICOM header (if any description was entered there).

Save the hanging protocol by selecting the Study Description, which is the most specific parameter

Save

to save on and click on the

button. However, if no study description is present in the

header data, the study cannot be saved while this parameter is selected. Users get the following
message, which means that the system has no way of matching a study to a protocol in this manner
because no description is given. If users do Save using the study description, only those exams with
the exact same Study Description entered in the DICOM header will be hung using this protocol.
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